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Information in this document is subject to change without notice. Spartan Bioscience assumes no responsibility for any errors that may appear 
in this document. This document is believed to be complete and accurate at the time of publication. In no event shall Spartan Bioscience be 
liable for incidental, special, multiple, or consequential damages in connection with or arising from the use of this document.

Research Use Only 

This instrument is for research use only and is not intended for clinical or diagnostic applications.

PCR and real-time PCR processes are covered by patents issued and applicable in certain countries. Spartan does not encourage or support the 
unauthorized or unlicensed use of PCR or real-time PCR processes. Use of this instrument is recommended for persons that either have licenses 
to perform PCR and real-time PCR or are not required to obtain licenses. 

Patents Pending 

The Spartan DX-12™ is protected by patents pending in multiple geographic areas. 

Trademarks 

Spartan DX-12™ is a registered trademark of Spartan Bioscience Inc.  All other trademarks are the sole property of their respective owners.
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Intended Use

The Spartan DX-12™ is designed to analyze purifi ed nucleic acids using nucleic acid amplifi cation techniques 
such as Polymerase Chain Reaction (PCR).

The Spartan DX-12™ is for research use only and is not intended for clinical or diagnostic applications.

Contact Information

The Spartan DX-12™ was developed and is manufactured by:

Spartan Bioscience Inc.
203-15 Grenfell Crescent
Ottawa, ON K2G 0G3
www.spartanbio.com

For more information: info@spartanbio.com
For technical support: support@spartanbio.com

Warranty 

The Spartan DX-12™ is warranted to meet or exceed the stated specifi cations. Spartan’s sole obligation and the 
customer’s sole remedy is limited to replacement of instruments free of charge in the event the instrument fails to 
perform as warranted. Spartan makes no other warranty of any kind whatsoever, and SPECIFICALLY DISCLAIMS 
AND EXCLUDES ALL OTHER WARRANTIES OF ANY KIND OR NATURE WHATSOEVER, DIRECTLY OR INDIRECTLY, 
EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, AS TO THE SUITABILITY, PRODUCTIVITY, DURABILITY, 
FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, CONDITION, OR ANY OTHER MATTER WITH 
RESPECT TO SPARTAN PRODUCTS. In no event shall Spartan be liable for claims for any other damages, whether 
direct, incidental, foreseeable, consequential, or special (including but not limited to loss of use, revenue or profi t), 
whether based upon warranty, contract, tort (including negligence) or strict liability arising in connection with the 
sale or the failure of Spartan instruments to perform in accordance with the stated specifi cations. 

Visit www.spartanbio.com/products/warranty_service/ for complete Warranty details and Extended Warranty   
information.

 

General InformationGeneral Information
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General Instrument Safety

  Before operating the instrument, it is important to read this Operator’s Manual thoroughly and  
completely. Non-observance of the operating instructions and warnings contained in this manual may entail 
safety hazards.

The Spartan DX-12™ must only be used by personnel trained and skillful in nucleic acid practices.

 Ensure that anyone who operates the instrument has:

• Received instructions in general laboratory safety practices and specifi c safety practices for the   
instrument.

• Read and understood all applicable Material Safety Data Sheets (MSDSs).

There will be protection impairment if the instrument is used in a manner not specifi ed by the 
manufacturer

In case of instrument malfunction please contact the manufacturer.

Symbols

In this Operator’s Manual, symbols are used as a visual signal to point out important information.

 I Important Note – This symbol is used to bring the user’s attention to an important annotation.

  Warning, Risk of Danger – This symbol is used to indicate that non-compliance with the instructions or 
procedures may lead to physical injury, or even death, or could cause damage to the instrument.

  H Biohazard - This symbol is used to indicate that certain precautions must be taken when working with 
potentially infectious material.

  MET International Mark with adjacent indicators ‘C’ and ‘US’

 % CE Mark (European Union)

  Manufacturer

  DC (direct current)

Safety and Standards ComplianceSafety and Standards Compliance
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 The Spartan DX-12™ is an electromechanical instrument. There is a potential danger to the user of an 
electrical shock or physical injury if the instrument is not used according to the instructions given in this manual. 
Observe all general safety precautions which apply to electrical instruments.

• The power supply cord must be inserted into a power outlet with a protective earth contact (ground).

• Unplug the power supply cord from the power outlet before cleaning the instrument.

• Do not use the instrument near water.

• The instrument should be operated only with the type of power source indicated on the marking label of 
the power supply.

• The instrument should be used only with the supplied power supply. If the power supply becomes 
inoperable, please contact Spartan Bioscience for a replacement.

• Always plug the power supply into the instrument, and then plug the power supply into the power outlet.

• Do not allow anything to rest on the power cord. Do not install the instrument where the cord may be 
walked upon.

• To reduce the risk of electrical shock, do not disassemble the instrument. Refer servicing to Spartan 
Bioscience authorized service personnel.

• Do not overload power outlets as this can result in risks of fi re or electrical shock.

• Unplug the power supply cord from the power outlet and refer to Spartan Bioscience authorized service 
personnel if one or more of the following conditions exist:

• The power supply cord or plug is damaged or frayed.

• If liquid has been spilled onto the instrument.

• If the instrument has been exposed to water.

• If the instrument does not operate normally by following the operating instructions. 

• Slots in the front and back of the instrument are provided for ventilation. To protect the unit from 
overheating, these openings must not be blocked. Keep an unobstructed space of at least 30 cm (1 foot) in 
front and behind the instrument.

Electrical SafetyElectrical Safety
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 Before handling any chemicals, refer to the MSDS provided by the manufacturer, and observe all  
relevant precautions. 

Chemical Waste Hazard

  Wastes created during use of the instrument are potentially hazardous and can cause injury, illness, or 
death. Refer to MSDS and local regulations for handling, storage, and disposal of waste. 

Waste Disposal

  Wear appropriate eyewear, clothing, and gloves when handling reagent and waste containers. Store, 
transport, and dispose of waste according to all local, state/provincial, and/or national regulations.

 H Although the Spartan DX-12™  works with purifi ed nucleic acids, be aware for your own safety that all 
biological samples such as tissues, body fl uids, and blood have the potential to transmit infectious diseases. Follow 
all applicable local, state/provincial, and/or national regulations. Wear appropriate protective eyewear, clothing, 
and gloves.

Read and follow the guidelines in these publications: 

• Biosafety in Microbiological and Biomedical Laboratories (BMBL) 4th edition (http://www.cdc.gov/OD/
ohs/biosfty/bmbl4/bmbl4toc.htm)

• Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR 1910.1030; www.osha.gov) 

• Additional information about biohazard guidelines is available at: www.cdc.gov 

If you suspect the instrument may have been exposed to any hazardous material, the instrument must be 
decontaminated.  If you are unsure about suitability of the decontamination or cleaning agent specifi ed in your 
laboratory decontamination procedure, please contact  Spartan Bioscience by e-mail at support@spartanbio.com 
or by phone from 9am-5pm EST at +1 [877] 228-7756.

Chemical SafetyChemical Safety

Biological Hazard SafetyBiological Hazard Safety
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%

This instrument has been tested to and complies with:

• IEC 61010-1, Safety Requirements for Electrical Equipment for Measurement, Control 
and Laboratory Use – Part 1: General Requirements.

• IEC 61010-2-010, Safety Requirements for Electrical Equipment for Measurement, Control 
and Laboratory Use – Part 2-010: Particular Requirements for Laboratory Equipment for 
the Heating of Materials.

• IEC 61010-2-081, Safety requirements for Electrical Equipment for Measurement, 
Control and Laboratory Use – Part 2-081: Particular Requirements for Automatic and 
Semi-automatic Laboratory Equipment for Analysis and Other Purposes.

• IEC 61010-2-101, Safety requirements for Electrical Equipment for Measurement, Control 
and Laboratory Use – Part 2-101: Particular Requirements for In Vitro Diagnostic (IVD) 
Medical Equipment.

• IECEE CB Scheme, including deviations from all participating countries. 

• IEC 60825-1, Safety of Laser Products

Standards ComplianceStandards Compliance
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Box ContentsBox Contents

12V Power Supply and Power Cord (Cat. No. 01004381)

Unpacking and Installation Instructions (Cat. No. 01001084)

DX-12 DNA Analyzer User Manual (Cat. No. 01001056)

Spartan DX-12 Quick Reference Guide (Cat. No. 01001057)

Spartan Analyzer Software User Manual (Cat. No. 01001044)

Release Notes (Cat. No. 01001058)

1 Spartan USB Drive Containing 
All Supporting Materials

(Cat. No. 01004429)

1 Spartan DX-12 
(Cat. No. 01004350)

12 Centrifuge Adaptors
(Cat. No. 01004247)

1 Setup Rack
(Cat. No. 01004357)

A Starter Pack of Spartan Tubes and Lids
(20µl PCR Tube Assembly, Tubes - Cat. No. 

01004153 and Caps - Cat. No. 01004155) 
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Unpacking

The Spartan DX-12™ is shipped in a cardboard container with molded inserts. The container should be carefully 
inspected for damage.  Report any damage to your authorized Spartan Bioscience dealer before accepting the 
unit. We recomend you read the unpacking and setup instructions.

The instrument measures 17cm (W) x 36cm (L) x 12cm (H) and weighs 4.2 kg. It is easily handled by one person.

Instrument Contents

Spartan DX-12™ Desktop DNA Analyzer (Cat. No. 01004350)

12V Power Supply and Power Cord (Cat. No. 01004381)

USB Drive Containing All Supporting Materials (Cat. No. 01004429)

12 Centrifuge Adaptors (Cat. No. 01004247)

1 Set-up rack (Cat. No. 01004357)

Starter Pack of Spartan tubes (20µl PCR Tube Assembly, Tubes - Cat. No. 01004153 and Caps - Cat. No. 
01004155).

  I The Spartan DX-12™ should be used with manufacturer-supplied accessories only.

Operating Requirements

This instrument is designed for indoor use only.

Operate in ambient temperature between 15 and 25°C (59 and 77°F).

Do not operate in a cold room or a refrigerated area.

Operate in ambient relative humidity of 20 to 50%.

These specifi cations have been calculated for altitudes between 0 and 2,000 meters.

Ensure adequate front and rear ventilation.

Installation 

1. Unpack and position the instrument on the workbench in the upright position. Allow 30 cm space in 
front and behind the instrument to ensure suffi cient cooling of the electronic components.

  I Failure to provide ventilation space may impact the instrument’s ability to maintain proper operating 
temperatures.  This could negatively impact your reaction results and cause the instrument to overheat. 

2. Store original packaging in a sae location in case, at any time, the instrument should require 
shipping.

3. Select a site for the instrument where:

• Ambient temperature is maintained at 15 to 25°C. Avoid direct exposure to air conditioning, heating 
vents, and direct sunlight.

• Relative humidity is 20 to 50%, non-condensing.

• Exposure to dust and drafts is minimal.

• There is minimal vibration to the instrument.

• An electrical outlet is available. The power supply automatically accommodates incoming voltages 
between 100-240 V AC and 50-60 HZ. Use of an un-interruptible power supply (UPS) is recommended.

4. Plug the power supply into the instrument and connect the power supply to power source.

5. The instrument is now operational.

Instrument InstallationInstrument Installation
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6.  Upon initial instrument running, we recommend you insert 12 empty tubes into the instrument, insert the 
provided UBS stick, navigate to the Options menu and initiate a report.  This should take 10-15 minutes 
to run.  Once it has been completed, please forward the results (3 fi les) to support@spartanbio.com so 
that we may verify the functionality of the unit.To set date/time:

To set date/time:

1. The fi rst time the instrument is started, you will be prompted to set the date and time.

2. Move to the appropriate “Set Date/Time” fi eld using the outside buttons and select using the center 
button.

3. Modify the fi elds using outside buttons and unselect by pressing center button.

4. Select “Save” using the center button to save your new date and time settings.

Decommissioning

The Spartan DX-12™ does not require any special action to remove it from use.  However, as with any electronic 

equipment, please follow all applicable local, state/provincial, and/or national regulations for disposal.

Instrument Installation (continued)Instrument Installation (continued)

Power Connector

Center Keypad Button

Outside Keypad Button

USB Slot

Flash Card Slot

LCD Display
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End-Point/Real Time and Melt Curve Operational Modes

The Spartan DX-12™ is shipped in “End-Point” operational mode. In order to operate the unit in “Real Time” or 
“Melt Curve” modes, these functions must be activated.  

To activate “Real Time” or “Melt Curve” modes:

1. Using the keypad, select the “Options” menu on the instrument.

2.  Move to “System Settings” using the outside buttons and select using the center button.

3. Once within the “Sytem Settings” menu, “Melt Curve” or “Real Time” modes can be turned Off/On 
by moving to and selecting the appropriate fi eld using the outside buttons and the center button, 
then toggling up and down with the outside arrow keys, pressing the center ket again to register you 
selection.

I The fi rst time you change the “Real Time” or “Melt Curve” operational setting, you will 
be prompted to “AGREE” or “DISAGREE” to a disclaimer.  If you do not “AGREE” to the 
disclaimer, the “Real Time” or “Melt Curve” modes will remain “OFF”, and will be inacessible.  
Only once the disclaimers are “AGREED“ to can you access these operational modes.

Reaction Set-up 

A. Thermal cycling 

The Spartan DX-12™ is designed to run two- or three-temperature thermal cycling programs. A  three-temperature 
program has three steps: denaturation, annealing, and extension. A two-temperature program combines the 
annealing and extension steps into a single step. Although three-temperature programs are more traditional, two-
temperature programs can provide the same performance while signifi cantly shortening run times. 

Isothermal programs may also be performed on the Spartan DX-12™ by setting the denaturation, annealing, and 
extension steps to the same temperature.

Note that the dwell time at each temperature begins once the reaction tube reaches the specifi ed temperature. 
For example, if the denaturation temperature is set at 95°C, and the denaturation dwell time is set at 10 s, the 
10 s countdown begins once the reaction tube reaches 95°C. For most applications, only a few seconds of 
denaturation time are suffi cient to denature the amplicon during thermal cycling.

Designing a Program

Each gene target is unique and may require optimization of the cycling program. Here are some general guidelines 
for determining the appropriate temperatures and dwell times for your program:

1. Design primers with matching melting temperatures (Tm), preferably between 60-68°C, and amplicon 
size of < 300 base pairs (bp). For faster cycling speeds, the primers should have Tms of 65-68°C, and 
amplicon size of < 150 bp.

2. Set the annealing temperature to the calculated Tm.

3. For three-temperature programs, set the extension temperature to  72°C for 10 s. For two-temperature 
programs, the extension temperature is combined with the annealing temperature and no separate 
extension time is used.

4. Set the annealing and/or extension time to 30 seconds.

5. For denaturation temperatures and times, we recommend starting with the following settings:

DNA Source Denaturation Temp Initial Time Cycling Time

Human/Mammalian 95°C 2.5 min 10 s

Bacterial/Viral 95°C 1 min 10 s

Operating InstructionsOperating Instructions
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B. Detection chemistries 

The Spartan DX-12™ is a 2-channel instrument. The fi rst channel detects green wavelengths (520-532 nm), and 
the second channel detects red wavelengths (620-800 nm). The detection system is compatible with standard 
probe chemistries such as TaqMan® probes, Scorpion probes and Molecular Beacons. It is also compatible with 
DNA intercalating dyes such as SYBR Green® (life Technologies). For probe technologies, Spartan recommends the 
use of non-fl uorescent quenchers such as BHQ-1 and BHQ-2 (Black Hole Quencher®, Biosearch Technologies). For 
further details, see Spartan Application Notes 005 and 012 at http://www.spartanbio.com/application-notes/.  

For SYBR Green I dye (Invitrogen, Cat. No. S7563), we recommend a concentration of 0.4X. However concentrations 
in the range of 0.2-1.0X are acceptable. For further details, see Spartan Application Note 0XX at http://www.
spartanbio.com/application-notes/.

 C. Reaction tubes 

The Spartan DX-12™ is designed to work with Spartan reaction tubes (20µl PCR Tube Assembly, Tubes - Cat. No. 
01004153 and Caps - Cat. No. 01004155). These tubes have been optimized for fast heating and cooling kinetics, 
and must be used to perform PCR on the Spartan DX-12.

Spartan reaction tubes are designed fto be loaded directly with a pipette tip. To load tubes, insert loaded pipette 
tip to the bottom of the tube, and slowly realease the liquid while raising the pipette, ensuring the tip of the 
pipette is kept at the surface of the liquid.  This should release the liquid evenly into the tube without creating any 
bubbles.

Operating Instructions (continued)Operating Instructions (continued)

Run ProgramRun Program

A. Warming Up and Turning Off

1. Plug in the Spartan DX-12TM.

2. There is no power switch on the Spartan DX-12TM. Turn on the instrument by pressing any key on the 
keypad, the welcome screen will appear.

3. Once the instrument is turned on, and you enter into the setup window, it will take about 10 minutes to 
warm up and equilibrate to room temperature.

4. To manually turn off the instrument, select “Off” from the Main Menu. When the instrument is turned 
“Off” all features of the instrument including fans and heaters are turned off.  However, the instrument 

D. Reaction volumes 

Spartan reaction tubes have a maximum void volume of 25 µl. The minimum reaction volume is 10 µl. Spartan 
recommends standard reaction volumes of 10-20 µl.
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is effectively in “sleep mode” and can be turned back on by pressing any button.

5. After 30 min of inactivity, the display screen will turn off. After a default time of 4 hours of inactivity, the 
instrument will turn “Off”.  This auto-shut off time can be changed through the “Options” menu, under 
“System settings”. 

6. To ensure that there is no power going to the instrument, unplug the power cord.

B. Selecting a Program

1. Use the left and right outside keypad buttons on the keypad to move to the “File” menu. Press the center 
button to select this menu.

2. To create a New Program, use the outside keypad buttons to navigate down to the “New” menu and 
select it. In the program setup screen, edit the name of your new program by pressing the center button. 
Use the up and down outside keypad buttons to adjust the characters, and use the left and right outside 
keypad buttons to move from one character to the next. When you are fi nished, press the center keypad 
button to accept the new program name.

3. To open an Existing Program, use the outside keypad buttons to navigate down to the “Open” menu and 
select it. Use the up and down arrows to move between programs in the program list. Programs will be 
displayed in numeric, then alphabetical order. Select a program by pressing the center button. Open the 
program by selecting “Open” from the options on the bottom of the screen. At any time, you may select 
a program using the center button, and use the outside keypad buttons to move between the “Open”, 
“Delete”, and “Cancel” options at the bottom of the screen.

C. Setting Up a Program

1. After you have created a New Program, or have opened an Existing Program, the Program Setup Screen 
allows you to specify settings for the Reverse Transcription, Thermal Cycling, and Melt Curve steps in your 
program. 

2. Use the outside keypad buttons to navigate between the program steps. Select “On” or “Off” to toggle 
the appropriate steps. Note that the instrument will perform the steps in the following order: Reverse 
Transcription → Thermal Cycling → Melt Curve. Steps set to “Off” will not be performed.

3. To save modifi cations to your program, select the “Save” option at the bottom of the screen. If you 
modify any of the three components of a program and run it without saving, the program will run as 
entered, but the the changes will be lost at the end of the run.

Run Program (continued)Run Program (continued)

Proper Tube Orientation
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Run Program (continued)Run Program (continued)

Reverse Transcription

1. To modify the Reverse Transcription temperatures and dwell times, use the outside keypad buttons to 
navigate to “Reverse Transcription” and select it using the center button.

2. In the Reverse Transcription Setup Screen, use the outside keypad buttons to navigate between the 
temperatures and dwell times. After using the center button to select a setting to change, use the up 
and down outside keypad buttons to change the values. Use the center button to accept the new 
entry.

3. Step #1 specifi es the Reverse Transcription synthesis conditions, and Step #2 specifi es the Reverse 
Transcription denaturation conditions.  Step #2 of the Reverse Transcription program, and Step #0 
of the Thermal Cycling program are performed sequentially when both programs are selected.  This 
should be kept in mind when setting up a program that involves a Reverse Transcription step.

4. When you are fi nished adjusting the values, navigate to the bottom of the screen and select “Ok”.

5. To cancel your modifi cations, navigate to the bottom of the screen and select “Cancel”.

Thermal Cycling

1. To modify the Thermal Cycling temperatures and dwell times, use the outside keypad buttons to 
navigate to “Thermal Cycling” and select it using the center button.

2. In the Thermal Cycling Setup Screen, use the outside keypad buttons to navigate between the 
temperatures, dwell times, and cycle number. After selecting a setting to change, use the up and down 
outside keypad buttons to change the values. Use the center button to accept the new entry.

3. Step #0 specifi es the initial denaturation conditions. During the cycling phase of the program, Steps 
#1, 2, and 3 specify the denaturation, annealing, and extension conditions, respectively. 

4. When you are fi nished adjusting the values, navigate to the bottom of the screen and select “Ok” by 
pressing the center button.

5. To cancel your modifi cations, navigate to the bottom of the screen and select “Cancel”.

6. By default Thermal Cycling is set to “3-Temp” thermal cycling conditions. To switch between two-
temperature and three-temperature programs, toggle the “2-Temp” or “3-Temp” option at the bottom 
of the screen by selecting it with the center button.

Melt Curve

1. To modify the Melt Curve temperatures and dwell times, use the outside keypad buttons to navigate 
to “Melt Curve” and select it using the center button.

2. In the Melt Curve Setup Screen, use the outside keypad buttons to navigate between the temperatures 
and dwell times. After selecting a setting to change, use the up and down outside keypad buttons to 
change the values.

3. Step #1 specifi es the initial denaturation conditions. Step #2 specifi es the starting temperature for the 
melt curve. Step #3 specifi es the end temperature for a single-step melt curve. Step #4 specifi es the 
end temperature for a multi-step melt curve. “°C/step” specifi es the frequency of data acquisition. The 
minimum and maximum increments are 0.1°C/step and 1.0°C/step, respectively.

4. When you are fi nished adjusting the values, navigate to the bottom of the screen and select “Ok”.

5. To cancel your modifi cations, navigate to the bottom of the screen and select “Cancel”.

6. By default, the Melt Curve program is set to “Single-Step”. A Single-Step program uses the same 
temperature increment from the starting to end temperatures. To switch between single-step and 
multi-step programs, toggle the “Single-Step” to “Multi-Step” option at the bottom of the screen by 
selecting it. A Multi-Step program allows you to set two different temperature increments between the 
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Data AnalysisData Analysis

Thermal Cycling

1. During a Thermal Cycling program, the fl uorescence intensity of each well is measured after the fi rst 
and last cycles. You may change from End-point detection to Real-time detection in the “Options” 
menu by turning on “Real-time mode”.  You must agree to the disclaimer before Real-time mode will 
be  turned on.

2. At the end of a Thermal Cycling program, you may view the fl uorescence results on the instrument’s 
LCD screen. Fluorescence values are displayed on a scale from 1 to 999. Display value = (fl uorescence 
last cycle - (minimum fl uorescence+1))/2000 (rounded to the nearest whole number) If the result is 
<01, display “00”.

3. When in “Real-Time” mode, data aquisition occurs following the Annealing/Extension step (Step 2) 
during 2-Temperature PCR, and following the Extension step (Step 3), during 3-Temperature PCR.

4. Selecting “Save” at the bottom of the screen saves the results to both the Flash card (2GB or less) or 

Run Program (continued)Run Program (continued)

Flash Card
(2GB or less)

USB Slot

Flash Card Slot

USB Drive

Center Button

Outside Keypad Button

starting and end temperatures. This feature is useful if you want higher resolution for a specifi c region 
of the curve, but want the overall run-time to be short.

D. Running a Program

1. Insert Spartan reaction tubes into the instrument. Ensure that the tubes are properly nested in each 
well. Do not force the tubes down into the wells. Close the instrument lid.

2. From the Program Setup Screen, select the “Run” option from the bottom of the screen.

3. While the program is running, you may increase the cycle number at any time by navigating to the cycle 
number denominator on the screen with the outside keypad, puching the center button to select it, 
and the up and down arrow key to make the changes, pressing the center button again to implement 
the changes.

4. While the program is running, you may also select “Stop” at any time. Note that the program is only 
stopped after you select “Yes” to confi rm stopping the program. When a program is stopped, all 
data accumulated to that point has been saved and is available via the “Save Last Run” feature in the 
“Options” menu.  If a Flash Card (2 GB or less), or USB drive is present in the unit during the run, the 
data will also be automatically written to the drive(s).



-14-

Spartan Bioscience Inc. | 203–15 Grenfell Crescent | Ottawa, ON Canada K2G 0G3 | Tel +1[877] 228–7756 | SpartanBio.com

© 2009 Spartan Bioscience Inc.

Data Analysis (continued)Data Analysis (continued)

the USB drives. 

5. To graph the results, remove the Flash card or USB drive from the instrument and insert it into the 
corresponding port of a personal computer (PC).

6. Data is stored as a “.txt” fi le on the Flash card or USB drive. The fi le will be saved with the following 
naming convention: AAAAAAA_UUUU_DDMM_RR.txt, where AAAAAA is the program name, UUUU 
is the unit ID number, DDMM are day and month, and RR is run of the day.  This data is encrypted and 
can only be graphed using Spartan Analyzer software that is supplied with the instrument.

I This data can ONLY be graphed using Spartan Analyzer software that is supplied with the 
instrument.

7. The User Manual for the Spartan Analyzer software is available for download at: http://www.spartanbio.
com/products/spartan-dx-12/manuals/

Melt Curve

1. During a Melt Curve program, the fl uorescence intensity of each well is measured after each temperature 
increment.

2. At the end of a Melt Curve program, select “Save” at the bottom of the screen to save the results to 
both the Flash card and USB drives in the instrument. 

3. To graph the results, remove the Flash card or USB drive from the instrument, and insert it into the  
corresponding port of a PC.

4. Melt curve data is stored in the same fi le as the Themal Cycling data. This data may also be graphed 
using Spartan Analyzer software.

5. The User Manual for the Spartan Analyzer software is available for download at: http://www.spartanbio.
com/products/ spartan-dx-12/manuals/

Custom Process Files

Although the Spartan DX-12™ comes with pre-set process fi les, it also offers the fl exibility of creating custom process 
fi les, allowing the user to create a more complex thermal profi le than that allowed through the graphical user 
interface (GUI).  Examples of custom process fi les can be found on the USB key shipped with the instrument.

Setting up a custom process fi le

1.  Custom Process Files can be setup using spreadsheet programs such as “Microsoft Excel®”, but must 
be saved and loaded as tab delimited text (.txt) fi les.

2. Custom Process Files are setup up in 5 columns, as seen in a basic example in the the table below (more 
detailed descriptions of each column follows in the next section):

• The fi rst row/header of the Custom Process File MUST be formatted as in the example below (# 
CUSTOM_PROCESS), for the fi le to be recognized by the instrument. 

•  After the header row, a “#” in front of a row represents a comment. Rows with “#” in front will be 
ignored by the instrument, and can be used to keep notes.

• Custom process fi les are setup in to two types of thermal profi les, “Set” or “Ramp”.  

Creating Custom Process FilesCreating Custom Process Files
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 During a “Set” temperature step, the instrument gets to the set temperature as quickly as possible. Set 
temperature steps only use the fi rst four columns, and the columns represent:

Thermal Profi le Type Set Temp (ºC) Dwell Time (s) Collect Data (Yes/No)

Set 37.0 300 No

In this example, the instrument would go to a set temperature of 37°C, for 300 seconds without collecting 
data, then continue onto the next row in the fi le.

 During a “Ramp” temperature step, the instrument moves from one set temperature to the next at a 
ramp speed that is dependant on the melt curve step size used. Ramp temperature steps use all fi ve 
columns and the columns represent:

Thermal Profi le Type Start Temp (ºC) End Temp (ºC) Collect Data (Yes/No) Step Size (ºC/Step)

Ramp 55.0 95.0 Yes 0.2

In this example, the instrument would ramp from 55°C to 95°C in 0.2°C increments, collecting data at every increment.

• When setting up a custom process fi le, “Set” temperatures, or thermal cycling, must be placed before 
“Ramp” temperatures or melt curves.  If the program is setup otherwise, it will not run properly and the 
instrument may crash.

• Temperature values must be set to one decimal place, so be sure, when setting up custom process fi les 
in Microsoft Excel®, that the temperature columns are appropriately formatted before saving your fi le 
as a .txt fi le.

• Both “Set” and “Ramp” temperatures can be set to one decimal place in precision, and “Ramp” step 
sizes in increments of 0.1 between 0.1 to 2.0.

• Programs can be designed to have any number of steps, so long as the previously described rules 
are followed.  For an example of a custom process fi le, with a “Reverse Transcription” step, 5 cycles 
of “Thermal Cycling” and a “Melt Curve” with 0.5ºC/step , 0.2ºC/step and 0.1ºC/step step sizes, see 
supporting material on the USB key provided (Custom Process Example.txt).

Loading a Custom Process File onto the Instrument

1. On the provided USB key, create a folder called “Process”, and load your newly created custom process 
fi le into this folder.

2. Mount  your USB key onto the Spartan DX-12™. Using the instrument keypad, navigate to the 
“OPTIONS” menu, then to “Load Process File”, and select using the center button.  The instrument 
will then locate the “Process” fi le on the USB key, and display the fi les available for upload.  Select the 
desired fi le from the populated list, and “Save” using the keypad.

3. Your new custom process fi le is now loaded and ready for use. 

Creating Custom Process Files (continued)Creating Custom Process Files (continued)

# CUSTOM_PROCESS

Set 37.0 300 No

Set 95.0 60 No

Set 95.0 30 No

Set 60.0 30 Yes

Set 95.0 30 No

Set 55.0 30 No

Ramp 55.0 95.0 Yes 0.2

Reverse Transcription Steps 
(reverse transcription (37°C) and 

enzyme denaturation(95°C))

2-Temp PCR (1 Step) 
(denaturation(95°C) and annealing/

extension(60°C))

Melt Curve 
(denaturation(95°C), 

annealing(60°C), and melt 
curve(Ramp) )

Creating Custom Process Files (continued)Creating Custom Process Files (continued)
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# Spartan test confi guration fi le ‘EXAMPLE’
# Created: Sat Jul 25 17:29:30 2009

Reverse_Transcription_on = Off
Rt_Temp1 = 37.0
Rt_Temp2 = 95.0
Rt_Time1 = 60
Rt_Time2 = 5

Thermal_Cycling_on = On
Tc_Temps[0] = 95.0
Tc_Temps[1] = 95.0
Tc_Temps[2] = 70.0
Tc_Temps[3] = 72.0
Tc_Times[0] = 30
Tc_Times[1] = 10
Tc_Times[2] = 10
Tc_Times[3] = 0
Tc_Cycles = 20
Tc_Is3Temp = Off

Melt_curve_on = Off
Mc_Temps[0] = 95.0
Mc_Temps[1] = 55.0
Mc_Temps[2] = 55.0
Mc_Temps[3] = 95.0
Mc_Temps[4] = 95.0
Mc_Times[0] = 30
Mc_Times[1] = 30
Mc_Times[2] = 0
Mc_PerStep[0] = 0.50
Mc_PerStep[1] = 0.20
Is_Multi_Step = Off

Editing Standard Process Files from your PC Editing Standard Process Files from your PC 

• As with the ”Load Process File” a “#” in front of a row represents a comment. Rows with “#” in front 
will be ignored by the instrument, and can be used to keep notes etc.

• Other than rows begining with the “#”, only the portion of the row following the “=” can be changed.

• Each row represents a fi eld that is editable through the instruments user interface.

• Set up a program fi lling it in as you would the setup on the user interface, making sure that the 

Standard Process Files

Standard Process Files are what is created through the instruments touch pad when you setup a program.  These 
fi les can also be setup on a PC, using spreadsheet programs such as “Microsoft Excel®”.  This may be useful when 
sharing programs between labs (for transfer through e-mail) or when programming large numbers of fi les at the 
same time.

Editing Standard Process Files

Standard process fi les are setup in the following format, which directly refl ects the process gone through on 
the instruments user interface:

This section defi nes Reverse Transcription.  In this 
example, the Reverse Transcription step is “Off”, but 
if it were “On”, it would go to 37°C for 60 seconds 
followed by 95°C for 5 seconds.

This section defi nes Thermal Cycling.  In this example, 
the Thermal Cycling step is “On”, and the program is 
set as a 2-temperature PCR (Tc_ls3Temp is “Off”).In 
this instance, the instrument would go to 95°C for 30 
seconds followed by cycling 20 times through 95°C for 
10 seconds, 70°C for 10s, ignoring Tc_Temps[3] and 
Tc_Times[3].

This section defi nes Melt Curve.  In this example, the 
Melt Curve step is “Off”, and the program is set as 
a single step melt curve (ls_Multi_Step “Off”).In this 
instance, if Melt Curve was “On” the instrument would 
go to 95°C for 30 seconds, then 55 for 30s, followed 
by a 0.5°C/step Melt Curve, ignoring Mc_Temps[4], and 
Mc_PerStep[1]. Mc_Times[2] must ALWAYS be set to 0.

Creating Custom Process Files (continued)Creating Custom Process Files (continued)

I A custom Process File CANNOT be edited through the GUI. When a Cuostom Process File 
is opened on the instrument, the following message will appear on the screen: “A custom 
process fi le has been opened.  This process fi le can be run but cannot be edited.” 
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In the “Options” menu, there are various optional settings and features:

1. Move to the appropriate “Set Date/Time” fi eld using outside buttons and select using center button.
Modify the fi elds using outside buttons and unselect by pressing center button. Select “Save” to save 
your new date and time settings. Note that it is important to set the correct date and time because a 
date-and-time stamp is saved with the fl uorescence results for each run.

2. To re-save the results from the previous run, select “Save Last Run”. Note that the instrument will only 
store data from the most recent run and that these results will be over-written with every additional 
run. 

3. To troubleshoot any problems you may experience with the instrument, select “Reports”. This will save 
an instrument status report to the Flash card and USB drives. The self tests will take 10-20 minutes 
for the instrument to perform.  The resulting report can be e-mailed to Spartan Bioscience for trouble-
shooting.

4. Some DNA amplifi cation assays for the Spartan DX-12TM come with pre-defi ned programs. These 
programs may be up-loaded to the instrument by saving them to Flash Card or USB under a folder 
named “process” and ensuring that they have a 7-digit name.  These pre-defi ned programs can then be 
loaded onto the instrument by inserting the Flash Card or USB in to the instrument and selecting “Load 
Process File”, choosing the appropriate program, and selecting transfer. Loading a process fi le with 
the same name as an existing one will overwrite the pre-existing fi le. Note that process fi les cannot be 
edited through the “Open” menu.

5. In the “System Settings” menu, you have the option of turning “On” or “Off” the “Real-Time Mode” 
and “Melt Curve Mode” features. You may also specify the duration of time before the instrument 
automatically shuts off after a period of inactivity.

Optional SettingsOptional Settings

appropriate thermal programs are set to “On”, and “3-Temp” (Tc_Is3Temp), and “Multi-Step” (Is_
Multi_Step) are setup as required. An example of the text present in a Standard Process File is shown 
above, see the supporting material on the USB key provided for an example of a standard process fi le 
(EXAMPLE - choose “open with” option on your PC and use either “Notepad” or “Microsoft Excel®” to 
view the fi le).

I Standard Process Files are loaded onto the instrument without fi le extensions.  To do this, 
save your completed process fi le in .txt format.  Before loading the process fi le onto the 
instrument, rename the fi le, removing the fi le extension.

Loading a Standard Process File onto the Instrument

1. On the provided USB key, create a folder called “Process”, and load your newly standard custom 
process fi le into this folder.

2. Mount  your USB key onto the Spartan DX-12™. Using the instrument keypad, navigate to the 
“OPTIONS” menu, then to “Load Process File”, and select using the center button.  The instrument 
will then locate the “Process” fi le on the USB key, and display the fi les available for upload.  Select the 
desired fi le from the populated list, and “Save” using the keypad.

3. Your new process fi le is now loaded and ready for use.

Editing Standard Process Files from your PC (continued)Editing Standard Process Files from your PC (continued)
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If you experience problems using the Spartan DX-12TM please visit the Spartan Support page (http://www.spartan-
bio.com/support/), or contact Spartan by e-mail at support@spartanbio.com, or by phone from 9am-5pm EST at 
+1 [877] 228-7756.

Self Test

If you feel that the instrument is not working to your expectations, navigate to the “Options” menu, and  with a 
Flash Card or USB connected the unit, select “Reports”. The instrument will take 10-20 minutes to export a report 
to the Flash Card or UBS drive.  The Report can now be transferred to your PC and e-mailed to Spartan Bioscience 
at support@spartanbio.com.  If you have any questions or require help with this procedure, please contact Spartan 
Bioscience by e-mail at support@spartanbio.com or by phone from 9am-5pm EST at +1 [877] 228-7756. 

  No user-serviceable parts are inside. Do not remove covers that require tool access. 

 Never clean the instrument without disconnecting the power cord.

  I  To prevent dust and debris from falling into the machine, keep the lid closed at all times.

Exterior

Clean outside surfaces as necessary with 70-100% ethanol or dilute bleach solutions (up to 10%).

  No user-serviceable parts are inside. Do not remove covers that require tool access. 

 I Refer servicing to Spartan Bioscience authorized service personnel.

For transportation or relocation of the Spartan DX-12™, use only the original packaging.  If you should require 
packaging, please contact please contact Spartan Bioscience by e-mail at support@spartanbio.com or by phone 
from 9am-5pm EST at +1 [877] 228-7756. 

TroubleshootingTroubleshooting

Cleaning and MaintenanceCleaning and Maintenance

ShippingShipping
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Complete system

Dimensions 17(W) x 36(L) x 12(H) cm 

Total weight 4.2 kg

Voltage requirements 100-240 V, 50-60 Hz 

Power consumption 12VDC, 6.5A,100W. DIN-8 connector (female)

Accessories included Spartan DX-12TM, User manual, USB Flash Drive, 12V 
power supply, 12 centrifuge adaptors, 1 set-up rack, 
starter pack of tubes, CD with Graphing Software

Warranty 1-Year Standard Warranty 

Optical module 

Excitation source 12 white LEDs

Emission fi lter Green: 520-532 nm / Red: 620-800nm

Detector 10bit CMOS Camera 

Fluorescence acquisition modes Real-time (every cycle) and end-point (fi rst and last 
cycle) 

Thermal module

Sample capacity 12 x 25 µl Spartan PCR tubes

Temperature Precision (°C) (3 min after start 
reaching set temperature)

± 0.05 

Temperature Accuracy (°C) (30 s after start) ± 0.5

Temperature Uniformity (°C) (30 s after start) ± 0.5 

Ramp rates (°C/s) Avg. 60-90°C: 3.0 heating, 2.5 cooling

Peak ramp rate (°C/s) 8.5

Warm-up time from ambient start 10 minutes 

Data output 

LCD display 7.0(W) x 4.0(L) cm 

Flash memory drive Stores data in .txt format for easy graphing 

Environment

Operating temperature 20-25°C 

Relative Humidity 20-50% noncondensing

Operating Altitude 0-2,000 meters

Operating Environment Indoor use only

Installation Category II

Pollution Degree 2

Appendix A: Technical Specifi cationsAppendix A: Technical Specifi cations


